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Warranty

All products manufactured by ICPDAS Inc. are warranted against
defective materials for a period of one year from the date of delivery to the
original purchaser.

Warning

ICPDAS Inc. assumes no liability for damages consequent to the use of
this product. ICPDAS Inc. reserves the right to change this manual at any
time without notice. The information furnished by ICPDAS Inc. is believed to
be accurate and reliable. However, no responsibility is assumed by ICPDAS
Inc. for its use, or for any infringements of patents or other rights of third
parties resulting from its use.

Copyright

Copyright 1997-2009 by ICPDAS Inc., LTD. All rights reserved

worldwide.

Trademark

The names used for identification only maybe registered trademarks of
their respective companies.

License

The user can use, modify and backup this software on a single machine.
The user may not reproduce, transfer or distribute this software, or any

copy, in whole or in part.

ek i ER R T P RASFE ) Fr 0T TR pER

Service@icpdas. com

http://www.icpdas.com EzProg-l Getting Started V4.0 21


mailto:Service@icpdas.com

=

1 EZPROG-I A 8 5
1.1 BB FEZPOIG-1 o s 5
1.2 EZProg-l1 o B £2 30 e 7

1.2 1 PAC'S ULIItY oo 7
A . O o ] o1 o T 7
2 T = €T o 8
O Y F= | 8
13 BB S T IR e 9
1.3 1EZCOre 28 VCHt i, 9
132 FEREL B AR oo 9
G TR B 4 o ] TP 10
1.3 EZHMI ..o 11
IR JL= =4 = ST 14
1.3.6 Eui%i;?:fffrb@ﬁjmﬂéﬁ?ﬁ@ ....................................................................................... 14

2 EZPROG-I#7i¢ * —‘,'5’ BT o 15

2.1 — 4@ % j‘;f B e 15
2.1.1 ¥|EzProg-I% fﬁ’;’zl;i? ........................................................................................ 15
2.1.2 ®]EzProg- Ij TRFETIR 2 15
2.1.3 FHEFIAT % gléﬂ FIFEVCAHITUIE? oo 15
2.1.4 F R I ﬁl :-JBIO B 2 e e 16
2.15 *ﬁ?ﬁé ‘Pf‘ Fi éjb%“ﬂl? .................................................................................. 16
2.16 F I L=t LIS I—,sEZHMI 2 ettt 16
2.1.7 #[:E‘}'———'I—,E{Ei” CBEEHBIIE 2 oottt 16
2.1.8 FER[ielR “%ﬁ‘ffl‘ I “—]:J'H—Ll_‘FF 2 16
2.1.9 EzProg- I Jﬂ }g‘ﬁf ?&F“ﬂ[lfﬁ’ 2 et e 16
2.1.10 JIffe (=S s J%lf%ﬁvj@? ............................................................................... 16
2.1.11 Fp'r JET! mf@ﬁ[l*ﬁﬁufll—ﬁ? ................................................................................... 17
2.1.12 [ﬁﬁ%{iﬁf FEEATIE? oottt 17

22 2 FPLC A RHDR T F e 18
2.2.1 EzProg-l EPLC HUTE[HIIIIE 2 oo 18
2.2.2 EzProg-I%ff!fT] FIJ@EWE’*’Q BB 2 et 18
2.2.3 EzProg-I® %&ﬁﬁm%ﬁﬁﬁ e ] LT 18
2.2.4 EzProg-| Eﬁpajgg&'-z%gﬁﬁfrﬁ TSRO 18
2.2.5 EzProg-I IO [l F%ﬁn 2 e e e e 18
2.2.6 i) F‘ﬁ&]‘?ﬁ?gﬁ‘!VC*E?“’? ................................................................................ 19
2.2.7 EzHMIZPLC fﬁ’_‘]\[ ............................................................................... 19
2.2.8 YIFHTIRIEE TUHMI’? ...................................................................................... 19
T2.2.9 ‘EJ;SFTfl‘JStep ) R ————— 19

23 %575 PC & A#H i » -ﬁ B3] e 20

http://www.icpdas.com EzProg-1 Getting Started V4.0 3%



2.3.1 EzProg-| fl—- ZIDERF Eﬁﬁj?"PF PP PP PPPRPPP 20

2.3.2 EzPorg-I% g rf’&"h[v[-,ﬂ S 2 ettt 20

2.3.3 EzProg-I EJ%’T?""‘]—RF?]EI R BT 2 oo 20

2.3.4 EzProg-I“EJ:fﬁﬂjiﬁﬁ?’EQrE'ﬁﬁF% D et 20

2.3.5 EzProg-I IO o [WFF#LIF[] 2 21

2.3.6 E'ﬁ'JEZHMI Eli}[l 2 e e 21

2.3.7 9p ﬁ"é(ibﬂfﬁﬂﬁfﬂ’? ............................................................................................ 21

3% XEZPROG-12PCrRB B IER .o 22
3.1% ;"’{SDKF#‘%;E‘?;’E‘( .................................................................................... 22
3.2 % FEZProg-1B 2 TR oo, 26
3.4 EzProg-1B 2 FiR(BAF B 51) oo 30

S D L BB B B e e 30
49 5§ B PEZPROG-IB ¥ #2578 5 Bl 31
4.1 F1 % EzCoNnfig FIORZ] .o 32
A2 B BRI B R oo 35
A3HMIF 2 F B FF0 3R 30 e 38
44 B FETIEBIRIZR oo 42
FEEEE 1o vvveeoeeeeseeeees s es e e e e ss e 43
Al # EzZHMI 4c > VSINET 2008.......ccooiiiieieee e 43
A2 G AR BT B3R e bbb as 46

http://www.icpdas.com EzProg-l Getting Started V 4.0 4t



1 EzProg-l /i &

1.1 +#+ 7~ &_EzPorg-l

EzProg-l £ - ¥4 Ek?* $E L S @RFET SR T EH AN P
&&ﬁ"':&*ﬁﬁm%ﬁ‘ﬁﬁ ° .é * ¥ i 51§ EzProg-l & %eha £ A2 5 T8 &4~ 4o

T8 10 B f MRl EzProg IR o KR el s 2 A
Fitha (HMI)N,% 3 EzProg -l #F& ek > d A EzProg-l M g e eVC++4.0
SPA L A#HBFT 5o [§s PILEY B VCHH L0 p (TR H o REAR
FTHEEEAE ar g o

EzProg-l i & chj¥ d 4o :
FEZFL R %

WinCE 5/6.0 peie® % 5t
EzFrocg e s

EzProg-1 = ¥R #2321 &
o ‘ =>EzConfig, EzEMI, EzGo, EzMake, Ez

= . LIB

[ e =1 R Ak eVOH B RS

= S B2 AES 4% RHE A EMA
‘%:ﬁ = -mj‘- BANBEFRET B TR 5 0

.
At

REhIHABES:

EzProg-1 # = WinCon/PAC #3#] B #%
PAC MP-8x43 .

%% USB & VGA %+ &t &

A T LEEER VA Y R

& TR 5w 4 (1GB CF or Micro SD)
% # DIO, AIO, Motion ¥ ¥4 I0 #-%&
B2 ELHI04414p 4

2y k¥ 46 => Ethernet,
RS-232, RS-485

http://www.icpdas.com EzProg-1 Getting Started V4.0 5t



Interrupt

System |1
task

RTSRTask | [19]74]

(0~7) ’—

User Thread | Iz
Task (0~7)
Sl Lo

Interrupt:

RTSR.

User Thread: !

HMI and Other: Periodic task without fixed time interval, attached Thread T6

T e K TR

EzProg-1 & & Fprirdleng BT £
B3, 2 WinCE T pF f st + &
EWEn S R sEETE S
GRER R R=s i B ok 1N

Bt S I RRT ARGRBAER
BRF41#25, EzProg-1 # &~
i® RSTR » ~ i® USER THREAD » 22 ¢ %t
JRIZAZR » 8B AR FTEFT,
¥ O P|IR P enr pi"r:}g:#d %

FHRIER 25 % LR ko LONG > DWORD > WORD - FLOAT » BYTE ¥ % » 2 483 &

PHWT FRFRERE,

GG A (ns) ¥ B B EHMPHE, ¢ 0T R4

PP RREE AT FHN
4 {45 % er3E ¢h 3 N & (BEzLib)

S ARG TR

ﬂ' ICP DAS CO,, LTD.
B EBARRA AR

#EzCore ENGINE start OK !!

http://www.icpdas.com

EzPorg-1 A # 7 & 4 ¢
EzHMI(ActiveX)

BT ESS 0k E

E 387 EzProg-1 p %% B4 i
B AW DI Bk
UNICODE % B3 % B % % 3%
A N B
LEFEEL A
AEFGE{ERY 5

$ ¥ 2 ¥ 7%k Windows F 3l
PETIE PSR D

$ ¢ ¥ 1% 2% Enable & Disable

EzProg-l Getting Started V4.0 61



1.2 EzProg-l 1 E f25%

1.2.1 PAC’s Utility
PAC WlnCon XPAC) Utility:

Rl L NeCessary
‘Geneard Setting mwmlmmwn]suwm

Mo shes to the left for mone mesmory bo n
iprograms.More sider to the right for more storage
oom.Ony unusid RAM can be adrstod.
Storaga Program
Mamory

ﬂ[ﬂ

[ S| s — |

InUse 2434k InUse G304
R Registry —
Backip Ragktry 05 and the other settings 10 3 fia. Tha default path & To durmp o Restors oy
folow for Rigeary.
[icompactRashiwiss Bk ba | Backun an | Dump Registry
5k the button o restore ol of settings from the sekcted . Restors A || | [ Restors Rogistry |

Active)
romsmr wsm"; lw |

Recover to Confirm
Factory Settings Sattings

!cf\ ICP DAS CO., LTD.
.- Akl 1A A )

[ contrm oty | ) pome

1.2.2 EzConfig

|-8077 | Slot2 _Siotd | Slotd | Slots _Slotf | Slot?

e B E TR

http://www.icpdas.com

Piirres 3

PAC Utilitys &% ris# ik
eha1 £

S T

¥FRETRAKR

SDRAM #2.;% &2 gk -] & fie .3
FTP/HTTP B:. /282 A& 2
pHEHETFRE
2 L 0S pr 1§ it
¥ Fx

REE P RRAGLP &
AREPETH

AP EE YR
M E ActiveX # &
X ELIEE &

P Zi M port ATH K

ARk - EzConfigax &,

g g 2 2 E AWinCon/PACH *

PEIERKERMERIBEY

DIO, 2 FRnet 10, m AIO:®3& #1 42
[l %5

216 }_ﬁa % &‘u%gcarM/D/F/
DB/C/T- 8%, % #2d B # & k4
fL2g 2k,

5983 R AL F PR
d gt % 31 EFEzCore %k B & .
S e AES # % 1 K|
T R Ry,
VLRI T A DS

B BT E.
XML #%.

EzProg-l Getting Started V4.0 7+




1.2.3 EzGo

PACEzGO

Advanced_Features
City,

@ Basic_Operation

EzGo £/ RFHER/ K HEEH
FPPRBEERETHE KT
EzGo #&

18092F, 18094 (F)% #- ‘szt
SREE AR B AR,
18094A(H) & #- e cipliR sk 3.
BIRSETE & W dd W RIER
Z 4p Rt 2 DIORRBEPIZE, f§ & e
P FRR,

UK T & E S I )
éifﬁe?] AR, RIFAER.

¥ BT ORIER R * D eh APL ¥ %k
» &Y.

P=Srmu

http://www.icpdas.com

EzMake £ & % £ 3] 5 E@ & 474
Bei-8094A(D Bk 3+ih- 21
B AZsn,

EzMake+# 14 i{f % »# & & %= WinCon
P21 E RRIFE SRS
BGK R, BT ek G HCE

o

RS T PR Y 07 BT R
BT PRRR R HE B AT
5.

EzProg-l Getting Started V4.0 81




1.3 &R F F Ak
1.3.1 EzCore ¥ VC++

WinCon WinCE 4/5.0 with Microsoft eVC++ 4.0

MPAC WinCE 6.0 with Microsoft VS 2008 VC++

= EzProg-1 #_A& **fcdc VCH B 3
k- ER R FRE,H
® &9 & EzCore(DLL),
EzCore £ A & 4 v g *
API, ¥ % % % & & % DIO, AIO,
Motion,” EzHMI, ¥ & # .

2 VCH B il and &
1k, ‘$ EzProg-1 & i@ &
TR BL VT A i
VCHE = [ 5 P ® # it

132 % B A+ B

BAA I WINCEOS #a WA +5%b 424 £ 1+ - & 10 APl &2 MFC AP,
£ - EEKEL&i* hEzCore & Ezlib 2 Motion APl B+ & % VC++
W HIAEA, A B TR & (EzZHM)Motion, & 8 # 1 & chfc & 8 ¥ .

Bzl PLTIEYE/Config . D

- : User Develop
Ie.VC++ 4.0 ﬂ EzMake Tools & GUI

. Control Engine
EzCore | EzLib | EzMot ion JSESUESUEISSE

Hardware Driver

WinCE RTOS ..

{EBKI0 WinCon CE System 10, Motion .
Communication ..

http://www.icpdas.com EzProg-l Getting Started V4.0 9t



EzProg-l - ékerfis* BEH BT NF LB FERIER S 1 42

| W g ExConiz 181
}

XML FREERER

EzConfig
HERIO HE
| HMIE&ET
PERIThaeasst
HIEA0K?

Y
e
it 2k TR

1.3.3 EzCore

EzCore'ﬁ%ﬁ%’-%ﬁmPLC ¥484Ea s 1 FEESCANR 7518 &2 iR B 5 -
#£9§ & #DIO(X.Y) /AIO /M/DIFIDB/CITIMSG... % % thAPI, & ip i APIfdt 22
"'“r*y Hiw B ?‘/Eﬂ%— & eh R &, 6]4-EzHMI,Motion,EzLIB £ % -

EzCore# & ~ B 2 ¥ #H {7 e7RSTR » ~ B H # {ehUSER THREAD » &
DI(i8048(W)), Motion(i8092,i8094 i 5)¥ ¥FIRF4ER » & 4 A 5l {7 f o,
IPRCBURTE TR i g 1S

4

http://www.icpdas.com EzProg-l Getting Started V 4.0 10+t



1.3.4 EzHMI

@ LED: Jﬁ
B3 T B

ERS IR M ES S L - & (LED)
R T

e

& SWITCH : BERY 1 R FY 2 AMERE T BRI

=-N=K 3
® Label : & #-/¢ * 5 Bim & B4t dga i@ -

@ ColorEdit : REET FW 460 7 NE > L1 FREKE

123 [IEEEEEN(l - |

ButtonST : # i * & ¥ Blom ehdede » * 30 2071 FinFIR LT 2 o

http://www.icpdas.com EzProg-1 Getting Started V 4.0 11+



@ ColorRadio : #& i *‘ﬁ $FE-BEPEHEHAN

2 0.Item1 2 5.Item1
@ 1.ltem1 2 6.Item1
 2.Item1 @ 7.Itemi
3 3.Item1 3 8.ltem1
3 4.Item1 2 9.ltem1

X' ColorCheck : #& i * ¥ 4 & 58 P ;i

I:I Message1

0.ltem1 [ 4.ltem1
1 1.ltem1 5. ltem1

2.ltem1 [ 6.ltem1
[ 3.Item? '

OK I Cancel |

W Position : # ## * % B Motion(i8092,i8094 £ i 7|)¢hiy 4 =% B R 2B i#

REKE -
T | N

T EzKnob @ & & » FRrZETAG P NBr SR LNL F ke

103 104

17
ot 1
102 7 105 /— 2 18
A~ T,
= 5 15
14

10

i

o5 Py : -
/ o = B 10
2 - : 101\ /106
P i 10000V 7 \
7V, =
v = /71

— 100 107 1

12

http://www.icpdas.com EzProg-l Getting Started V 4.0 12+



EzSlider: i * X9~ 2 A A6 > * W@ > ST ke -

= = 0.000

0.000

= OEzlist: B * ¥ F ¥ SHA S it g1 FdIkE

2009/03/16 15:24:30 BIrsEHLHAE

2009/03/16 15:24.:28 BIrSEHLHAE

2009/03/16 15:24.:25 BIrSEHLHAE

2009/03/16 15:24:22 BrSEHFL A8

http://www.icpdas.com EzProg-l Getting Started V 4.0 13+



1.3.5EzLIB

EzLIB # &= { g * 25V
CERT AR E

HEB-p R

L3 i ehh 2 (CDC) 3 W+ &t
BMP PR Ak B W i

i 3 TCP/IP b 4% &t

{2 chFTP @ 4% &t

.Trend A% @+ st

1.3.6 &t EH I BE TR

EzProg-l ¥ 12 & 32 i8092F ~ i8094 ~ i8094F ~ i8094A -~ i8094H % 5| 2 pher
4 3h 5 L:@’i‘ha‘s‘;# |+ @ & EzProg-l &2 EzGo 2 EzMake i * B+ 1 i $4p b chi
HHNERE

Wt e AR 8092 - 8094 + i8094H ApBE & ¥ L p o

http://www.icpdas.com EzProg-l Getting Started V 4.0 141



2 EzProg-l #7i¢ * & {52

AR R BB H *‘f‘f i % EzProg-l en— B iE* 54 0 ¥ 1 AT
FApar T KRR > BB ARER G FRP S LB ARREY
EzProg-l % — & 3 #* eh¥3l o

e RS B E
DO # i+ IO%?J:".,%L(EE M)
DI #&ix IO%?]% BL(R B x)
Al gﬁbbﬁg’f])‘(ﬁ}ﬁi\‘ it
AO ﬁﬁb“@’fl (R BT

21“‘5}‘;!%? F‘ a'é

2.1.1 * EzProg-l 3 @ % a?

1 et ZRERR o

2. ¥ ”?Wﬁ’flfi FeR AR A RA RV LR -
3.FNMEEp L BESRE RO R VRS e v

4. aFF EzProg-l A# Y » FraE2 e han R BAAMET 2 p e
RAcEsar > W4cp 2 ERE N4 o

2.1.2 % EzProg-l % & B 4e;\rg ?

& > EzProg-l - = & 3 VC++42;% » EzProg-| # - 2Bt 1 feffsc i B3
% %eh 3o EzProg-l @ - BiFeh VCH+ 8 4 B SDK 374 BHpf - 2 7
FE P T R

213 AFAEN T REZT LT VAT VC 2582

% & > EzProg-l = j§#— £igfech VC++ &2 % 5 SDK 45 4 41 > &
Il ‘?%?" B APIF B4 * > Glde& 4] 015 DOB-ON R & ™
OUT_Y(01,true); ¥ 1243#] DO ON
OUT_Y(01 false); 1& 12 #:4] DO OFF
3§ Lar#l ¢ A DO W s & e £

http://www.icpdas.com EzProg-l Getting Started V 4.0 15+



214;%&?u§%wﬁmng?

¥ 11 > EzProg

-l ik EzConfig 1 &> E&7F N1 E¢ B £PHF I0H
e nlOfKe ¥

#
#7133 DIO > Nor¢4uo

2
F

-t

e

215 A BFiTha F 5 KiE?

2% % % > EzProg-l ¥ EzHMI & 54— & ¥ * o HMI $ i+ i* (ActiveX) » &
*%Rsﬁﬁ—QWQﬁtﬁaz;&% v gk R P R EOE G o bled
BE7 DIKGEE® LED# > PR E$EEATF - 2% B HMI éhagst o

2.1.6 ¥ & % WiE x EzHMI ?

¥ 1 EzHMI ¢ & 3 poz2 Unicode % W3 & > K3 E & copy/paste » T’n“
.uﬁf]» 3| EzHMI ActiveX ® » ¥ 3 MLx File ¥ 3% #% 1000 & % @3 s 4 o

21.7 5 B 5 1xE b s ?

2% % 5 EzHMI g~ ﬁl% %ol % 2 D 8000 ##¥ =+ % DB8000=0~7,
7 R LHT 0-7 5 W3 )

Zi8ﬁﬁmﬁﬁﬁ§a??ukﬁéf%?

¥ 1 s EzProg-l 7 #& i EzConfig 1E,EHVNM £ 7 B #PRIEDIO
AIO e & F R Fg > ¥ 00 ) - K)%%ﬁ‘x ﬁ&?’ﬁﬁﬂﬁ*ﬁﬁi
”ﬁmﬁﬂﬂﬂﬁ’?uﬁﬁﬁﬁﬁﬁf&
2.1.9 EzProg-l 4|2z 4o@ ?

EzProg-l ¥ #& & & 2ms e pF RTSR SCAN loop 3%t » RTSR &8 i 2
r"rwﬁrmregﬁ TALR — X T pr B ] o
2.1.10 4@ FE NPT EA?

2% % % » EzProg-l ¥ ¢ 7& PiE AES 4c 4] > R SR vk - H A
B VNS b4 T I RRESEEL T

http://www.icpdas.com EzProg-l Getting Started V 4.0 16+



2111 A7 B (TR AeH g7

VLo A0S * EE Windows CEOS ) B EF BB E_ eVC++ 4.0 K7 M ik
HEROEIATHFED  PHN o

[J}

f
2112 R EP-E L FBFHFEE?

70 APy &%k EzTemplate By B ERR T T BR LB F 4
PRl R EER -

http://www.icpdas.com EzProg-l Getting Started V4.0 17+



2.2 .

2.2.1 EzProg-l & PLC # 73

r":—}’

shoB 2

2.2.2 EzProg-l 3

PLC 427 A # it * ¥
Ap 12 eE

37 > EzProg-l #& & RTSR Scan &4 {73 /& > 4 PLC ¢ Scan {73 &

xé’*-ﬁ"’uiﬁ’* PLC k3B A K™ -

?

R BE ?

7 *EzProg-l #&#- % #agr PLC 4p i T & G4 IO e XY, il M &
2+ D(long)¥ % & ~ DW(DWORD) # # & + W(WORD)¥ % £ - B(BYTE)# i E
F(Float)¥ % B& % - p % EzProg-Z & ¢y s B

o 4T %

b

Register|Specification] Remarks Register[Specification Remarks
X Local DI X0000 ~ X0777 D General DO ~ D4095
Remote DI  |[X01000 ~ X07777 Retain D4096 ~ D8191
v Local DO Y0000 ~ Y0777 B General BO ~ B1023
Remote DO [Y01000 ~ Y0Q7777 Retain B1024 ~ B2047
AO |Local AO AO000 ~ AO511 W General WO ~ W1023
Al Local Al AI000 ~ AI511 Retain W1024 ~ W2047
T |General TO ~ T299 DW General DWO ~ DW4095
C General CO ~ C511 Retain DW4096 ~ DW8191
Retain C512 ~ C1023 = General FO ~ F2047
General MO ~ M8191 Retain F2048 ~ F4095
M Retain M8192 ~ M16383 DB |General DBO ~ DB49
S [General SO ~ 8191 MSG |Retain MSGO ~ MSG249
2.2.3 EzProg-l § ¥ § 4 cn@ Bty 5 Be§ 2

7 'EzProg-l sn@ iz E 4 04 307 WL

2.2.4 EzProg-l 3 3 R &E 5K FE ?

4 o deH A Y THC e

2.2.5 EzProg-1 10 Bkirie & 7 7?

DI=>X %55 >DO=>Y #5 »AO> Al i{iﬁ!’“ﬁ]ﬂ!%%fﬁ v ot 222 % o

http://www.icpdas.com

Bed¥ 4ot 2.2.2 4 Retain Wi

EzProg-l Getting Started V 4.0 18+




2.2.6 doim ikt VC #2587
FEBM & VC++ ¢ R & % dgon If (F 2 5%) {iFdg 4, TF bilde

If (IN_Xa(01)) OUT_Y(01,true);
4% DIO1 % ON RB| DOO1 % % ON

22.7EzHMI & PLC A {5 #® % & ?

EzProg-l1 énEzZHMI E_ e fe - F41B? # 7 > FP 72 * AL A K GRFTAH
FILEFR{AE P E -l aE R BT EANS P Y - BT F XA VGA
3 S S g N gr,‘g‘-g—h_g,’a Lo
2.2.8 4oim R-FTHE T ] HMI?

EzProg-l - 2 #3 RE4- D> F> MSG & » ¥ 7 % EzHMI = Lable
3% iig{i, Lablejjv:‘,? ,u,ég‘;‘p s A # ggé}ﬁ_ = -2

2.2.9 7 ¥ Step K35 ?

$oden A d SHG

http://www.icpdas.com EzProg-l Getting Started V 4.0 19+



23 ¥%

- f

B 4

PC #% hafehi * ¥ %3]

2.3.1 EzProg-| # - % IDE B % # M5 ?

#* £ EzProg-l £- 2 & E T 4

SR g riE v & ER T Microsoft

VC++ T 4 %M % WINCE 5% 425 » H 4~ PC ¥ thVC6 B % PC ¥ 425 2
> R* &5 > ipM IDE & Debug # & ,rm; EEAVCH B o

2.3.2 EzPorg-Il #

2

§ TR P AT

7 > EzProg-l & & #8287 PLC 4p i enE & » Gl4-R 1 10 9 XY, ALAO ##

#_v% ?

¢ M #:2 - D(long)¥ % E - DW(DWORD) # % %  W(WORD)# % % ~ B(BYTE)
Eap- X dzl ipfuf’f‘%ﬁ».a rERE-

ﬁl? % F(Float)%'l} x%- a3 20y u

P @ EzProg-2 & ¥ B# FlicT %

Register|Specification] Remarks Register[Specification Remarks
X Local DI X0000 ~ X0777 D General DO ~ D4095
Remote DI  |[X01000 ~ X07777 Retain D4096 ~ D8191
v Local DO Y0000 ~ Y0777 B General BO ~ B1023
Remote DO [Y01000 ~ Y0Q7777 Retain B1024 ~ B2047
AO |Local AO IAO000 ~ AO511 W General WO ~ W1023
Al Local Al AI000 ~ AI511 Retain W1024 ~ W2047
T |General TO ~ T299 DW General DWO ~ DW4095
c [Gen eral CO ~ C511 Retain DW4096 ~ DW8191
Retain C512 ~ C1023 = General FO ~ F2047
General MO ~ M8191 Retain F2048 ~ F4095
M Retain M8192 ~ M16383 DB |General DBO ~ DB49
S [General SO ~ $8191 MSG |Retain MSGO ~ MSG249

EEET Y T PR

User Thread

2 Fenk

2.3.3 EzProg-l 7

2

F

Retain Wi > @it

T RIS ER

ot o

P’UE°

2.3.4 EzProg-l

-

B 5 3Lk ? > bl4e EZHMI &7 RTSR &

TRFDREY RS ?

$ o ded A ? T C o

http://www.icpdas.com

» EzProg-l @44 B(2 8 R0« 354 15 71
%&ﬁgm#&@

lﬁ'f})\l—"ﬁ?*ﬁ—’ik}#

o
B * > @ |0 & General #Rixs ¥ UK

F P EAIRES ?

FHF > ot 232 %

BT - A

=
T}D A =L
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2.3.5 EzProg-1 10 gZhdrie 4] ?

EzProg-l 73 DIO,AIO # . %5 § EzConfig ##{fs + #i>#e » DI=>X %
A2 DO=>Y 475 » AO > Al v (REBS T~ &7 > 40t 23240 R &
*Apke APl k4T F @ F ¥ P > 28 40— 10 Frame Work - fi4 >
@ EALEHE-BIORT AR HAPI & FL- T BERAL -

2.3.6 B % EzHMI & 4cim i@ % ?

EzProg-l &7 EzHMI - i 5| ActiveX # > 38 % £ = & eVC++$i12(Dialog)
¥ ¥ i * Modeless k47§ ehF & » 3% & * DoModal * * ki * » @
ActiveX e { #7+ 8> d EzCore k7@ * —‘,‘5 7% B Code kI ATFH o

2.3.7 4eie R RE PFEH?

EzProg-l # & 8 i# RTSR = 7 | > & £_% p¥ 1 CallBack Function - i
PHEF LR 2MS(F ) AR AR Fie- KRR A RAEEEARINT £
P 72 ¥ ¥ fe & Timer function» gk G423 X % F Birdis i - e & EzHMI
ARG 0 RPFPERRIEFAFRRRE -
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3 % % EzProg-l &= PC ehR % % 3%

3.1 % % SDK B % TR

Stepl.%ﬁ-:]%’: »"MACHINE AUTOMATION" % %k ge3] inchse gidd, € p ffad % X
Bl IrERy pERFHFEERFTCDY Launchexe F ¢ I RIrT F & ¢
#%# Install EzProg-I

MACHINE.,AUTOMATION

Install PC-based Products
Install PAC Products
Install EzProg-l
Install ETM Series
Browse CD Contents
View Our Website

Contact Us

Step2. ## MP-8x43

EzProg-l
Software Packages

Please choose the installation for
your target platform.

WinCon 8x3x GM1

WinCon 8x8x GM1

MP8x43

Main Menu
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Step3.i£# Install SDK for MP-8x43

EzProg-hior MP-8x43

Please choose the SDK to install.
Install SDK for MP-8x43

Install EzProg-l for MP-8x43

Main Menu

Step4. £ “Next”

&' XPacSDK for Windows Compact Edition Setup E

Welcome to the XPacSDK for
Windows Compact Edition
Setup Wizard

The Setup Wizard will install XPacSDK for Windows Compact

Edition on your computer. Click Next to continue or Cancel to
exit the Setup Wizard.

' Next ]

MNext > I I Cancel l
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Step5. EH#& “Accept” & F & “Next”

#' XPacSDK for Windows Compact Edition License Agreement

Frd-Liser | Icense Agresment

Ba sire fo carefully read and undarstand the followdng end-usar license agresment, and
then indicate whether you accept o do not accept the terms of the agreement.

This software will not be installed on your development werkstation unless you accept the terms of
the erd-user licerse agreemeant. For your fubure reference, you can print the fext of the end-user
licerree agreement by clicking the PRINT button.

SOFTWARE LICENSE TERMS A

WINDOWS EMBEDDED CE 6.0 CUSTOMIZED OEM SOFTWARE DEVELOPMENT
KIT for

XPacSDK for Windows Compact Edition, 1.2.0

These license terms are an agreement between you and [ICP DAS Co., Ltd.] ~
Press the PAGE DOWRN key o see more text,

Prirt [ < Back et = | [ Cancel ]

Step6. fig » & * X "é-ﬁ-i P Liis R “Next”
Customer Information
Please enter your austomer information

Liser Name:

Organization:

l cgak | next> | l Cacel |

i\

Step8.31#-iF# “Custom” » # £iF# “Complete”

# XPacSDK for Windows Compact Edition Setup b?\

Choose Setup Type

Choose the setup type that best suits your needs

~

Custom

E Allows users to choose which program features will be installed
and where they will be installed. Recommended for advanced
users,

Complete
All program features will be installed. (Requires most disk space)
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Step9. #-# “Documentation” FF B H > RisR “Next”

i XPacSDK for Windows Compact Edition Setup

Custom Setup

Select the way you want features to be installed.

Click on the icons in the tree below to change the way features will be installed.

#- 2| Native Development Support Documentation of the WINCE platform
=~ | Microsoft NET Compact Framework APls

=-|Common

Documentation
= Will be Installed on local hard drive requires OKB on your
S8 Entire feature will be Installed on local hard drive

I Reset l l Disk Usage l l < Back MNext = Cancel

Stepl10. #& “Next” » R FlE#H 7 & { 2R BT

i XPacSDK for Windows Compact Edition - Destination Folders

Destination Folders

Click MNext to install to this folder, or click Change to install to a different folder.

G Install ¥PacsDK for Windows Compact Edition to:

CProgram Files\windows CE Toolshweet00WPacsDK_ZEY

| Py |
< Back I MNext > " l Cancel
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Stepll.4% Install 4% %

i XPacSDK for Windows Compact Edition Setup

Ready to Install
The Setup Wizard is ready to begin the Complete installation

Click Install to bagin the installation.  If you want to review or change any of your installation
settings, click Back, Click Cancel to exit the wizard.

< Back I Install H l Cancel

3.2 % % EzProg-| B % TR

Stepl3j46 » EZProg-l % H & @3] i enk i, § B $0H % KRN - dodh i
BREFHFEHRF CD P Launch.exe ¥ § 4T § &
#%E# "Install EzPorg-I”

MACHINE.AUTOMATION

Install PC-based Products
Install PAC Products
Install EzProg-l
Install ETM Series
Browse CD Contents
View Our Website

Contact Us
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Step2.i# “MP-8x43"

EzProg-l
Software Packages

Please choose the installation for
your target platform.

WinCon 8x3x GM1
WinCon 8x8x GM1

MP8x43

Main Menu

Step3.:£# “Install EzProg-I for MP-8x43”

EzProg-hfor MP-8x43

Please choose the SDK to install.
Install SDK for MP-§x43 |

Install EzProg-l for MP-8x43 |

Main Menu
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Step4.3% “Next”

EzProg-| Setup

Waolcome to the InstallShield Wizard for ExProg-1

The InstallShield® Wizard will install EzProg-| on your computer. To oo e
-

Install e

Company Nome:

Irsteal 516 <Back ||L['—|n+m_|
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Step6.3%" Next” -5 » E#% 7 8 { 3K

EzProg-| Setup

% R AT
X

& Des

Step7.# “Next” B 4s% %

EzProg-| Setup
Re o b

Invstallatien settings. elick Baek Click Canesl 16 exit i wizand

Install e ' e F!
—_—

Step8.% £ ¥ {53HiE “Yes” BT WEATRH

EzProg:-| Setup

1
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3.4 EzProg-l B % ¥ iR (4 & § 61)

PCi# 1 % %ICPDAS# #-2 EzPRog-Ith% £ ¢ » { FSETUPexe #FR % &

B 3 C:\ICPDAS\EzProg-l »

= S |ocal Disk (C)
# | Documents and Settings
= (3 ICPDAS

= | EzProg-I
= ) EzHMI Activex
) ocx

L) EzTemnplate

= | ) Manuals

# | ) English

# | ) TraditionalChinese
= ) Sample

# | ) Sample for EzCore

# | ) Sample for Motion
# | ) Tutorial for EzTemplate

# | EzTemplate_640x480
# | EzTemplate_8S00x600
# | EzTemplate_1024x765

35 1R FEEp

FEHLP SR

Manuals

Directory

(4 EzCore_API_V4.3tcpdf

(4 EzLIE_AFI_¥4 3tc pdf

(4 EzProg-]_EzTemplate_tutorial ¥1 1tc pdf
(L EzProg-]_Cetting Started_4 2tc pdf

(4 EzProg-1_Tool 4 6tc pdf

C:\ICPDAS\EZPROG-I\Manuals\TraditionalChinese

(2 iB092F_Getting Started_2 3tc pdf
(0i8002F Marmal 24 _to pdi
(18004 _Getting Started_2 4t pdf
(018004 _Manval_2 Ste pdf

(180044 H_Cetting Started_1 3e pdf
(iB004H_Manval 1 3tc pdf

C:\ICPDAS\EZPROG-I\Manuals\TraditionalChinese
\Motion
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4 5§ E enEzProg-l & * 425 # &

AR F AN~ JHADIO K™ + kb1 IB054(E & Slot 1) 3 6 -
pe s ) °

[ ol 01 DI.COM

ol 02 DIO

ol 03 DI

[ol 04 DI2

4 el 05 DI3

EIO - [ el 06 D4

) = el o7 DIS

# i [ a || 08 [l

i gl U=l 09 DI

pean oo ] e if 10 Do
_|| i e | 1 DO
DC MUY + ! o Nl [ o 1} 12 002
= ol 13 D03

= [yo il 14 D04

a Lol 15 D05

DO7 = ol 16 D06

51 HEX K Do?
el 18 DO.GND
[all 19 DO.GND
[ell20 DO.PWR

*ERHE Y DIO~7 - - &3] DOO~7: 4t DO JH,?%{;«T’L B 34T DI%?]%%_L
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4.1 41* EzConfig # 10 &3]

KO R4 =>"F255 §7 ¥ fad EzConfig 4o R

v

“¢0., LTD.

| PerMount Td 9 Wincon Utilit] . EzGo

s SR oy A PR A ]
- B

@ Programs
i:g Favarites
) pocuments | BB command Prompt
[ Settings | @ mtemet Bxplorer
S Run.. EF Microsoft WardPad

85tart | | B=l1CH & Windows Explorer

Are you sure 2
All data will cleared !

LEJaem

%’Etart IQJICPDAS EzConfig Tools For E...
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SCAN =z = {24 @

& NS s ARG A RS
& 5tart || sel1croas Ezconfin Took For E... [ zezem [B]A

L35 X0~7Y 0~7 4= W

q.hst 18054 W F¥ g F|p &

o
i8054

———————DIBD0B can't use ——

= y 4 :
[l15a5 Exconto Tock Foree” LE) 226

Lot

T URE DIX B Ak 2 #84(Y1,Y3.)iRI# DO 241 » & OK 4R -
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ICP DAS CO., LTD.
BAAEFH IR A AT B PR 3]

LE) 22z P

14 "EXIT" 3R EzConfig
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42 R FHEFL S

Stepl. HF4H - FRFHKE S
C:\ICPDAS\EzProg-I\EzTemplate\EzTemplate_800x600 ¥] C:\MyProject
L E@@ ® MyProject A

: @ 0 File Edit view Favorites Tools Help o
@Bk - @ - P Osearch ‘[{_?-Fo\dera‘ = (¥ Copy the EzTemplate_800x600 ]rch ‘[i’f Folders ‘ | (¥ .
 Address |ifi'| CAICPDAS\EzProg-1\Ez Template v | B g file to the MyProject folder I "| G0
Folders * | Mame -~ ICErs X Mame -~
5 @ Local Disk (C)) A | DEzTemplate_640x430 L] .« wpp- |=EzTemplate 500,600
¥ () dfS22fdesdsbS80d1977 Egﬂiﬂﬁliifggﬁggé  CIcPDAS
# | ) Documents and Settings B | Intel
= [ ICPDAS ® [y MSOCache
= [(2) EzProg-1 t
® () EzHMI ActiveX  — ® [ Program Files
# [ WINDOWS 1
# (2 Manuals ® () Windows CE Tools
® [ ) Sample ® e Local Disk (D)
® [2) Tutorial for EzTe o ® b Local Disk (E:) g
< m | 5 & | Bl T | 5 & | £
1 objects selected 4 Wy Computer 1 objects (Disk free spe O bytes 4 My Computer

Step2. # “EzTemplate_800x600" F#l & £ #7é £ 7 “MyFirstProject”

® MyProject |;||E|[)Z| B MyProject
¢ File Edit View Favorites Tools Help a

F QBak - @ - F O Search ‘[f“ Folders‘ & (¥
| Address ‘b Cr\MyProject v | 5o v | & Go
Folders * | MName Name

® |5 Documants and Settir IﬁEzTempIate_SOOmel OMyFirstProject

# (3 [CPDAS

® ) Intel ) Irtel

® ([[5) MsDCache [ Ms0Cache

]
# | Program Files () Program Files
® ) WINDOWS ® () WINDOWS

® [5) Windows CE Tools
® age | ocal Disk (D0
® Sge | ocal Disk (E:)
< ' | 3 =8 |
1 objects (Disk free spe O bytes o My Computer

® [ Windows CE Tools
® Sge | ocal Disk (D)
® Sge | ocal Disk (E:) 3
< i | ¥ € | >
1 cbijects (Disk free spe O bytes 4 My Computer

|
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Step3.i#¢ * Visual Studio 2008 F gz MyFirstProjcet F# & p i
“EzTemplate.sin” %

® MyFirstProject _

© File Edit View Favorites Tools Help ]

QBak - ©Q - ¥ Psearch ‘[{:“ Folders‘ & X N

: Address |E:| C: \MyProject\MyFirstProject v | G0

Folders X | Mame )
® [[3) Documents and Settir @ || Sres —

kil A_Template.cpp

® [ ICPDAS [0 A_Template.h
B 3 Intel 1 buttonst .cop
® ) MSOCache [ buttonst b
EzTemplate
— | D EzTemnplate
FEzTemplate
® () Program Files kel EzTermplate.cpp
® [ WINDOWS (B EzTemplate.h

® () Windows CE Tools o ®EzTemplate rc

¥ | BlF+Temnlate wenrni
< | > < | B

Size: 1.19KE Type: Microsg 1,19 KB 4 My Compiter

W

Step4. B kcis » #€_Project >EzTemplate Properties it » & &g
File Edit Wiew |Project | Build Debug Tools Test Window Help

ol v 5 v 5 %8 AddClass... N
¢ AddResource..,
Solution Explorer - | 122 Add New Item... Ctrl+Shift+A
=R IS Add Existing Item...  Shift+Alt+A

(& Solution EzTern [y New Filter
FEzTemplate

é‘.’l Show All Files
Urload Project

References. ..

Set as StartUp Project
Custom Build Rules. ..

Tool Build Crder. ..

EzTemplate Properties...  Alt+F7
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Stepb.

1.3 Linker=>General E &

2.#- Configuration % # “Release”

3.8 14 % Output File 2z 5 “$(OutDir)\MyFirstProject.exe”
4.#%- Configuration ¥ # “Debug”

5.7 Output File :x 3 “$(OutDir)\MyFirstProject.exe”
6.4~ “Apply” £7 R L

EzTemplate Property Pages

Configuration: |Release v | Platform: |Active(XPacSDK_CE (%867 v | [
®- Common Properties Output File $(OutDir)*IMyFirstProject.exeI
= Configuration Properti Show Progress Mot Set

General Wersion
Debugging Enable Incremental Lirking No (/INCREMENTAL:NO)
Deployment SUppress Startup Barner Yes (NOLOGO)
wC/CH+ Ignore Import Library Mo
= Linker Register Output Mo
General Per-user Redirection Mo
I“DL?t . Additional Library Directories
E\Aiagn.‘%s_th_lﬁ_le Lirk Library Dependencies Yes

7% “OK” MPEEAGHEE

http://www.icpdas.com EzProg-l Getting Started V 4.0 37+



43 HMI $ 2§ & 4%+

Stepl.f|* ¥ &4 - & LED # # 3| Dialog ¢ » 4T §
1. B# “Resource View” 3R BRLART

2. #% “IDD_EZTEMPLATE_DIALOG”

3. #w—- B EZHMILED $ #3546 +

4. =¥ Property BEBMELTE

°d EzTemplate - Microsoft Visual Studio

File Edit ‘iew Project Build Debug Format Tools Test Window Help
+ . N I i (33
EYRAEERAr=N"™ N NEEEEEN = b Release ~ z
BE] 1= dl Tk [ M ol i i (T |- XPacSDK_CE x86 Device » %2
2 Double click Template.rc ...IALOG - Dialog* ¥ X |Toolbox v 01 X
&l EZHIMIL LOIOrEAIT ...
IDD_EZTEMPLATE_DIALOG "
= — I 3. Drag EzZHMILED B EzHMI ColorRadi...
_________________________________________________________ object onto dialog ¥ EzHMI EzKnob C. .
=] IDG_EZTEMPLATE_DIALOG|— EzHMI EzList Con...
£ 1DD_Page01 [Chinese (Taiwe % EzHMI EzSlider C...
=] IDD_Page0?2 [Chinese (Taiwe N d& EzHMI Image Co...
=l IDD_Page03 [Chinese (Taiwe B EzHMI Label Con...
= IDD_Page04 [Chinese (Taiwe @ EzHMI LED Contr...l
=l IDD_Page0s [Chinese (Taiw: . || ¥ EzHMI Position C... o
=l IDD_Page06 [Chinese (Taiwe . —
= IDD_Page07 [Chinese (Taiw: Fupes s v 1 X
= IDD_Page(s [Chinese (Taiwe EzTemplate Project Pro-
T aivee i
(_ :”Mi: — :
&@Solutl... [BClass ... [Resou... | < | E7Tamnlat ™
Ready
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Step2. K 24T H
Select X/Y/M/S/TIC : RealDI X
XIYIMISITICno—=>LED(On/Off): 0

Flash Timer 0,1,2... : 2
IDC_LEDCTRL1 (ActiveX Control) Property Pages bS]

General

Appearance Styles: Multi-Language Caption:
|LED Type [RECTANGLE v [ Font. ]
|Border81y\e_ NONE v [[] Display Caption Language 0. v
: || |
: * | |
1
‘ * | |
; | |
Color: Register Type and Nurnber Assignment;

staus Texton Color. || NN |SE,|eCt Y IMISITIC RealDlX v

als e oor g quwsmmo —sLED(ONOH |0
(OFF Color, _ Refresh Interval (Unit 50ms)

|F\ash Timer 0,1,2 2
BackGround Color:

[ QK H Cancel H Apply }

Step3.4#F & - B SWITCH # it ¥] Dialog * > 4T H :
1. &% - i Switch %% &% &
2. BL¥ Property BEcBIEE

°d EzZTemplate - Microsoft Visual Studio
File Edit ¥iew Project Build Debug Format Tools Test Window Help

ER AT RAA™ N= I TN &~ b Release ~ E

bl 1= Sl TR ok [E] b4 e 2 HHE @3 XPacSDK_CE %86 Device v E

Resource View - EzTe... w [I X EzTemplate.rc ...IALOG - Dialog* ¥ X Toolbox - 1 X

=-Z EzTemplate 2 W EzHMI EzSlider C... »
= C3 EzTemplate rc* ) 1. Drag EzHMI Switch ) /& E2HMI Image Co...
=3 Dialog _ object onto the dialog B EzHMI Label Con...

D0_ESTEMPLATE—
IDD_Page01 [Chir g
IDD_Page02 [Chir )
IDC_Page03 [Chir
IDD_Page04d [Chir
IDD_Page05 [Chir ]

[ i

[

[

@ EzHMI LED Contr...
5% BEzHMI Position ...
@ EzHMI Switch Co...
= General

There are no usable o

IDD_Page(06 [Chir : -
IDD_Page07 [Chir ] C = " Properties v 01 X

IDD_Page08 [Chir : .
IDD_Page09 [Chir
= MM Damain [rhir =

< | > : ~
= . - ] 4. Open the property pages v
qSoluti... [FClass ... [@Resou. . [||| © & [ of the Switch object :
Ready TTOE o ™ 44 % 10
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Step4d.ik 24T B
Switch Type : SWITCH TOGGLE
Select YIM : E2

Select Y/M : RealDO Y
Switch(On/Off)>Y/Mno : 0

Flash timer 0,1,2... : 2
IDC_SWITCHCTRL1 (ActiveX Control) Property Pages

2%

eneral

Appearance Styles:

Multi- Language Caption:

BackGround Color

Iwitch Type |SWITCHTOGGLE v l ot }
Calor: [ Display Caption Language @ v
| Status Text On Color

0 | |1 | \
| Status Text Off Color

2 | s | |
| ON Color
| OFF Color | |5 | |
| 6. | | 7 | \

Register Type and Number Assignrment

YiM Enable

ISelect 1M

RealDO Y v

| Swilch(On/Off) —> YiMno |0

|Mno(0n) -= Lamp
Control Status

00000000

|Mno(On) —> Disable ActivexX  [00000000

Refresh Interval (Unit S0ms)

[Flash Timer 0,1,2

P

| ok

|| cancel ][ Appy |
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£ 1% KBE ¥ - B LED 22 SWITCH - &% COPY (Ctrl+C) -
£ f1* Paste (Ctrl+V) T H s 7ok 8icTH

‘8 EzTemplate - Microsoft Visual Studio

File Edit Wiew Project Build Debug Format Tools Test Window Help

. = =a N Ea | i - 13
A~vE~ S % @ 9~ &~ P Release 2
e 12 Sl ol [F] b s 4[] 83 EE (| xpacsDK_CE x86 Device 2
é%" EzTemplate.rc -...DIALOG - Dialog| EzTemplate.rc -...iwan)] - Dialog ¥ X
% I || L ER T T T T T T T S T T O S S T T I T T T S T S SO SO EO SO TN T O T T TR N S K S SO S S AT S S SR R N B T
= — ~
:j S
m
>
o)
o K
21l
&
]
b
@
= -
T 3
z | >
[l — : = =
Ready 1266, 37 i 31 x 18

BTOK B ATH N e 7 i i
% LED ¥ ¢ X/IY/MIS/T/Cno>LED(On/Off) i A s =
01" »*02" »703" »”04" +”05" »"06" »”07"

#- Switch # & Switch(On/Off)>Y/Mno i B #x =
” 01” N ” 02” N ” 03” ) ” 0471 , ” 05” N ” 06” ) ” 0771

v BB R # o
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4.4 % K Echn2 R

REGE F5 AT PR GRLARRER LD ) UG8 R R e
iﬁfﬁl'ﬁ&’;—* EACERLFEBREY > 2PAC Fo N RSTHRGTEG i,’n?,l‘l—fgi'l
LED &5 » i8054 X O ki » in+» ¥ X4 4% Switch % i8054 Y O #i5 J) 15 -

t

=

My
Documents

e LE) e
Jopt TR S - ﬁ Henfpdlagst o

FET‘ on/off —“"JF'?E;ELII‘ET_

on/off

My
Documents

# DO SWITCH
EL“ﬁj[J on/off

o BT L sz P
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Y

Al # EzHMI 4 >~ VS.NET 2008

Stepl.R kx EzTemplate qj‘avf:vuj% % o

EEzTemplate 6 KB Microsoft Visual Studio Solution

Step2. g% View-> Resource View

W Project Build Debug Format Tools
=] Code Cirl+Alt+0
l—“_? Solution Explorer Cirl+Alt+L
4 Bookmark Window Cirl+K, Clrl+W
% | Class View Crl+shift+C
C@& Code Definition Window  Cirl+Shift+y
[F7] Object Browser Cirl+Alt+]
=] output Alt+2
,:1 Property Manager
i_a—l Resource View Ctrl+Shift+E |

Step3. ## IDD_EZTEMPLATE_DIALOG R #c DIALOG # & -

Resource i - EzTemplate
=-Z EzTemplate A
=3 EzTermplate rc*
=-3 Dialog
=|IDD_EZTEMPLATE_DIALOG |
=] IDD_Pagell
=l IDD_Pagel?z
=l IDD_Pagel3

Step4. B:-# View->Toolbox
IVieWIProject Build Debug Format Tools

[Z] Code Cirl+Alt+0
I:_:' Solution Explarer Cirl+Al+L
) Bookmark Window Cirl+K, Cirl+Ww
g | Class Yiew Cirl+Shift+C
1 Code Definition Window  Cirl+Shift+y
@3 Object Browser Crl+Alt+]
=] Outout Alt+2
ﬂjl Property Manager

LE'] Resource View Cirl+shift+E
S Toolbox Ctrl+Alt+X
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Step5. & Toolbox B-# +4EiE&"Add Tab” -

wn Date Time Picker
|E& Month Calendar Confrol |
€ Custormn Confrol
Abl CAPEdit Control
B State of Input Panel Control
= EzHvT] |

F_&

There are no usable cortrols in this group. Drag
an item onto this text to add it to the toolbox,

= General v
Step6. gL - T “EzHMI" #-C E R o

Step7. B-# Tools>Choose toolbox ltems...

Tools | Test  Window  Help
_;‘L Attach to Process. ..

Cirl+Alt+P
3‘.;.‘, Device Security Manager. ..

El;- Connect to Device. ..

E; Device Emulator Manager. ..

c'J,—- Connect to Database. ..

‘{3 Connect to Server...

:;5 Code Snippets Manager...  Cirl+K, Cirl+B

| Choose Toolbox Items...

Step8. i& »"COM Components” F & » #&¥# EzHMI #t}

s “OK” > 4rT § :

Choose Toolbox Items @@

MET Framework Components| COM Comporents |WEF Components | Activities

Name
1 DTC Designer

Path

C:\Program Files\Microsoft Visual Studi..

Library

Microsoft DTC Fra..

£ .~

EzHMI ButtonST Control (ICP-DAS V...
EzHMI ColorCheck Cortrol (ICP-DAS L.
EzHMI ColorEdit Comtrol (ICP-DAS ...
EzHMI ColorRadio Control (ICP-DAS ...
EzHMI EzKnob Control (ICP-DAS W2.2)
EzHMI EzList Contral (ICP-DAS W2.2)
EzHMI EzSlider Confrol (ICP-DAS W2.2)
EzHMI Image Control (ICP-DAS W2.2)
EzHMI Label Control (ICP-DAS V2.2)
EzHMI LED Control (ICP-DAS W2.2)
EzHMI Position Conrol (ICP-DAS W2.2)
EzHMI Switch Control (ICP-DAS V2.2)

CACPDASEzProg-INOOMBUHoNST .ocx

C:\CPDAS\EZProg-INOCKMCOLORC ~1....
C\CPDAS\EzProg-INOCKACOLORE~ ...
CA\CPDAS\EZProg-INOCMCOLORR~1....

CHCPDASEZProg-TYOOOEzKnob .ocx
C:HCPDASEZProg-INOC\EzList.ocx
CHCPDASYEZProg-TVOC EzS lider (OCK,
CAHCPDASEZProg-IYVIC Image, oox
CACPDAS\EZProg-IVOCKLabel .ocx
CHCPDASEZProg-TOOM ED .ocx
CAICPDAS\EZProg-IYOC\Position.ocx
CHCPDASYEZProg-TVOCSwitchocx

ButtonST Activex ...
ColorCheck Activ...

ColorEdit Activelx ...
ColorRadio Active. ..
knob Activex Con...
Ezlist Activex Co...

SLIDER Activex C...
Image Activex Co...
Label ActiveX Con...
EzHMI LED Contr...

Position ActiveX ...

EzHMI Switch Co...

<

-1 WideoSoft FlexfArray Control

Language:  Language Neutral

Wersion: 30

Browse...

| ok “ Caricel ] I

Reset

http://www.icpdas.com

el § %?] > “EzHMI”

TiE Bede &
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$7% & EZHMI 4 236 § 4t 4c » “EzHMI” tab 425 -
= EzHMI
k Pointer
EzHMI ButtonST Cortrol (ICP-DAS W2.2)
P EzHMI ColorCheck Control (ICP-DAS W2.2)
&8 EzHMI ColorEdit Control (ICP-DAS V2.2)
@ EzHMVI ColorRadio Control (ICP-DAS ¥2.2)
% EzHMI Ezknob Control (ICP-DAS W2.2)
= EzHMI EzList Control (ICP-DAS W2.2)
W EzHMI EzSlider Control (ICP-DAS W2.2)
& EzHMI Image Confrol (ICP-DAS W2.2)
B EzHMI Label Conitrol (ICP-DAS V2.2)
@ EzHMI LED Control (ICP-DAS ¥2.2)
5% EzHMI Position Control (ICP-DAS W2.2)
[ @ EzHMI Switch Control (ICP-DAS v2.2) |
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A

g{

2 i 2R

z & MPAC i s

Stepl. & VS.NET 2008 * #-# Tools>Options...

File Edit Wiew Project Build Debug Format|TooI5‘Te5t Window  Help

A-E~EHd P Fe8 |5k Attach to Process. . Cirl+Alt+P
¥PacSDK_CE x86 Device » 8k [ .| 8 Device Seaurity Manager...
Resource View - ... v 1 X EzTemplate.rc —:DI E]? Cornect to Device...
3 Digleg ~ | \3.;3' Device Emulator Manager ...
= IDD_EZTEMPLATE L = -
=l IDD_Page01 [Chines - ?J; Correct to Database...
IDD_Page02 [Chines 1
= C tto S
ID0_Page03 [Chires || | B cornect to Server
IDD_Pagel4 [Chines b ::'J Code Snippets Manager...  Cirl+k, Cirl+B

Step2. E B = # 4 » «h “Device Tools” i£# “Devices” > X

=] IDD_Pagell [Chines ]

=] IDD_Page16 [Chines

= IDD_Page19 [Chines

i) o (] @

i G

IDD_Page0s [Chines
IDD_Page06 [Chines
10D _Page07 [Chines
IDD_Page0s [Chines
IDD_Page03 [Chines
IDD_Page10 [Chines

IDD_Pagel2 [Chines
IDD_Page13 [Chines ]
IDD_Page14 [Chines -
IDD_Pagel5 [Chines 1

IDD_Pagel7 [Chines
IDD_Page18 [Chines

IDD_Page20 [Chines ]
IDD_Pagez1 [Chines -
IDD_Page2? [Chines ]
IDD_Page23 [Chines
IDD_Page24 [Chines
DD _Page2s [Chines
IDD_Page26 [Chines
IDD_Pagez7 [Chines -
DD _Page28 [Chines 7
IDD_Page2d [Chines 4

Choose Toolbox Items. ..

Add-in Manager ...

Macros

Find More Extensions...

Create GUID

Dotfuscator Community Edition
Error Lookup

ATLMFC Trace Tool

[LDasm

Spy++

Wisual Shudio 2008 Command Prompt
WCF Service Configuration Editor
External Tools. ..

Import and Export Settings. ..

Customize...

I Cptions...

) -

# "Properties...” #4 -

# Projects and Solutions
#-Source Confrol

- Text Editor

#- Database Tools

= Deblugging

= Device Tools

# HTML Designer
- Dffice Tools
- Test Tools

#- Help &
~Import and Export Settings
International Settings
Kevboard
Startup
Task List
Web Browser

O Factors

Shiow devices for platform;

[xPacsoK_CF

v

Devices:

Save As...
Rename...

Default device:

KPacSDK_CE x86 Device

)

0K ] I Cancel

http://www.icpdas.com
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Step3.& “Configure...” &4 -

XPacSDK_CE x86 Device Properties §|g|
Default output location on device:
| “|
Trarsport;
|TCP Connect Transport N | l Corfigure. .. l
Configure. ..
Detect when device is discornected
oK l l Cancel

Step4. E4#& “ Use specific IP address” - #& ?é@?]% MPAC &1 IP i=ht {3

“OK” MPFERALTE o

Configure TCP/IP Transport

[(JUse fixed port number: I:l

Device IP address

®) Use specific IP address:

(O Obtain an IP address automatically using ActiveSync

1127.00.1

QK l l Cancel l

Step5. ] MPAC &R BEEFHFT 5|3 BRHHZ 4T W :

\Windows\CommanClinet2
\Windwos\CMAccept

http://www.icpdas.com

EzProg-l Getting Started V 4.0 47+



%2 MP-8x43
File Zoom Display  Tools Help

Fle Edit View Go Favorites [|]4|¢|

I]]Agdress Sincowes

|

| Size | Type | Date Modified |
P File Folder 1/6f2010 3:05 AM
File Folder 1/6/2010 4:06 PM
| Fanits File Folder 1/6/2010 4:06 PM
I Programs File: Folder 1/6f2010 2:09 AM

File Folder

1/6/2010 8:05 AM
{2010 4:06

1) Double click "ConmanClient2"
2) Double click "CMAccept"

25KE  Application
61.5KB  Application

60 bytes  Shortout

1172007 3:20 AM
1172007 3:20 AM

J3KE  Application Extension  7/20/2002 432 PM

Bf26/2009 8:27 PM

Step6. w3 VS.NET 2008 - g.# Tools>Connect to Device...

T §]

Tools || Test  Window  Help

EL

{8
1

S22 | Device Security Manager ...

EI-;'

Connect to Device. ..

=

Device Emulator Manager ...

Step7.:5# XPacSDK_CE » {34 “Connect”

Connect to Device

a platform, then choose a device below.

Flatform:

To connect to a physical device or launch an emulator image, select e —

Attach to Process, .. Chrl+Alt+P

Cancel

XPacSDK_CE

‘|

Devices:

http://www.icpdas.com
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ok BRAARENRAF TR o T F

Connecting...

2 :

To WPacsSDK_CE x86 Device'
Connection succeeded.

Close
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